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Welcome to ReCycle 2.1!

 

First of all we’d like to thank you for purchasing ReCycle 2.1! You are now in 
possession of a unique tool which will be an enormous time saver and which will 
add great creative possibilities to your music making.

Before ReCycle, using drum loops was very technical. Also, once you had com-
mitted yourself to a sample, you were stuck with its inherent tempo, its bass 
drum pattern, its snare sound etc. A bit like painting by numbers.

With ReCycle all that has changed. This program puts you – the musician – 
back in control, and lets you concentrate on what you do best. Which of course 
is creating music.

 

What can I do with 
ReCycle?

 

With ReCycle, you can perform a number of pretty amazing “tricks” on your 
drum and music loops:

• Change the tempo without affecting pitch.
• Change the pitch without affecting tempo.
• Quantize drum loops (either to straighten up the timing or to change the feel, 

for example by applying a “groove map”).
• Extract the timing (a groove map) from a drum loop. This can then be applied 

to other sequenced parts or even to other loops!
• Replace individual sounds in a drum loop.
• Edit the actual playing in the drum loop without affecting the basic feel.
• Extract sounds from loops.
• Process the loops with various effects.

 

Copyright Issues

 

The raw material with which you feed ReCycle is drum loops, grooves, break-
beats, or whatever sampled weirdness you find appropriate. Included in this 
package is a great selection to get started with. When you grow out of that you’ll 
find a wealth of other sampling CDs and CD-ROMs out on the market to pick 
from. However, please read the following text carefully:

Every published recording carries a warning, like this:

• "All rights of the producer and owner of the recorded work are protected by 
law, unauthorized copying, public performance..."

The text above means it is illegal to use this recording in your own work, unless 
you obtain permission (see below). 

 

!

 

Failing to observe a copyright warning may result in legal action 
taken against you. Make absolutely sure any material you use in 
your own recordings is cleared for use, or you may find yourself in 

 

serious legal trouble!

 

Some CDs (and other media) are created specifically for sampling. Even then 
you must ensure the result is properly cleared for use in your own recordings. If 
you find a disclaimer text that goes something like the one below, beware:

• "Every effort has been made to ensure that this CD contains sounds you can 
safely use in your music. However, the producers of this product can not ac-
cept responsibility for any direct or consequential loss..."

In this case, please contact the producer to find out exactly what applies. Again, 
do not use any material from this medium without making sure it is properly 
cleared for use.

 

Clearing

 

So, how do you go about obtaining permission to use a recording, often referred 
to as “clearing a sample”?

The owner of a CD is listed on the CD, in conjunction with a “P” symbol and a 
date. Contact the owner to obtain permission. If you can’t find the owner, con-
tact the company following the © symbol on the CD. If you can’t find that either, 
contact the manufacturer or record label listed on the packaging. Please note 
that there are several types of clearance, for different types of usage. Preferably 
contact an attorney familiar with copyright law, for assistance.
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About This Manual

 

Mac OS vs. Windows

 

The documentation is both for the Mac OS and Windows versions of ReCycle 
2.1. Most pictures show the Macintosh version but things are identically titled 
and positioned in both versions.

Sometimes, a key command is different in the two versions. This is indicated like 
this: Hold down [Option] (Mac) / [Alt] (Win) and...

Everything said in the manuals applies to both platforms, unless explicitly stated 
otherwise.

 

On-Line Help (Windows only)

 

• ReCycle for Windows has on-line help with a Menu Reference, window help 
and help for specific dialogs from within the program.
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Macintosh Installation
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Computer Requirements

 

You can use ReCycle on any computer that runs Mac OS X version 10.2 or 
later.

 

Finding your way on the 
ReCycle CD-ROM

 

Once you have turned on your system, insert the ReCycle CD-ROM. At the root 
of the CD-ROM, you will find a file called “Read Me”. Double click this to get in-
formation about what is what on the CD-ROM.

 

Installing the Acrobat 
Reader

 

To be able to read the online documentation, you must have the Acrobat Reader 
application installed. If this isn’t already installed on your computer, you need to 
install it from the ReCycle CD-ROM:

 

1. On the ReCycle CD-ROM, open the folder “Acrobat Reader” and 
double click on the file “Reader Installer”.

2. Follow the instructions in the dialogs that appear.

3. At the end of the installation you may be required to restart your 
computer again. Do so.

 

Installing ReCycle

 

1. On the CD-ROM, double click the icon named “Install ReCycle”.

2. Use the options in the dialog to select a destination and follow the 
instructions on screen.

3. Click the “Install” button.

 

!

 

Don’t launch ReCycle yet! You need to perform some additional 

 

steps first: 

 

Read the Read Me file!

 

In the ReCycle folder that was created on your hard disk during installation you 
may find a Read Me file. This will contain any late-breaking updates that didn’t 
make it into the manual. Please double click on it and read it before proceeding.

 

Register your software!

 

Registering gives you immediate access to various benefits such as free, extra 
sounds for ReCycle 2.1! When you first launch ReCycle 2.1 you will have the 
opportunity to register your software on-line.

 

!

 

You must have a working Internet connection to be able to register 

 

on-line.

  

DDDD

 

If you click the Register Now button, your Internet browser will 
launch and take you to the registration page on the Propellerhead 
web site.

 

Follow the instructions on the web page.

  

DDDD

 

If you don’t want to register at this point, click the Later button.

 

You can register at any time by selecting Product Registration from the Con-
tact menu (Mac) or Help menu (Windows) in ReCycle 2.1 (or by going to 
www.propellerhead.se/register).
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Launching ReCycle

 

1. Locate your ReCycle program icon (in the new “ReCycle” folder on 
the hard disk, 

 

not

 

 on the CD-ROM) and double click on it.

2. The program prompts you to insert the ReCycle CD-ROM (if not al-
ready in the drive).

 

This is only required the first time you run the program.

 

3. A dialog box appears, asking you to enter your name, company and 
serial number. Do so, then click OK.

 

Your license number can be found on the product authorization card in-
cluded in the package. Again, this procedure is only required the first time 
you run the program.

 

4. Finally, an Open dialog appears, asking you to locate an audio file 
for opening.

 

Setting up Audio

 

The audio hardware is the computer equipment that converts the digital signals 
from ReCycle to analog audio signals (for connection to an amplifier, head-
phones, or similar). This equipment could be a standard stereo sound card, the 
built-in audio hardware on a Macintosh or some more advanced audio card with 
several inputs and outputs, digital connectors, etc. Regardless of which, you 
need to make sure the hardware and its drivers are properly installed:

 

If you are using the built-in audio hardware of the Macintosh

 

In this case you don’t need to make any extra settings. Just connect the audio 
output to your listening equipment (speakers, mixer, headphones or similar) and 
make sure your Mac plays audio properly.

 

If you are using other audio hardware

 

You may want to use other audio hardware with ReCycle. For this to be possi-
ble, the audio hardware must be compatible with Mac OS X, that is, there must 
be a Mac OS X driver available for the card.

 

5. Install the audio hardware and its drivers as described in its docu-
mentation.

6. Connect the stereo outputs of your audio hardware to your listening 
equipment (speakers, mixer, headphones or similar).

7. If possible, test that audio plays back OK with the audio hardware.

 

With some audio hardware, a test application is supplied for this purpose.

 

Audio Card Driver 

 

After launching ReCycle, you should open the Preferences dialog (Audio page) 
on the ReCyclet menu and check the Audio Card Driver settings at the top. If 
you click the pop-up, all available drivers installed are shown. The Built-in audio 
controller is always available as the default output.
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If you have an audio card with multiple outputs, you can select 
which output pair you wish ReCycle to use by clicking the “Chan-
nels...” button.

 

Built-in audio or dedicated driver?

 

ReCycle can either use the built-in audio controller or a dedicated driver to play 
audio. Basically, the following simple rule can be used as a guide:
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If you have a sound card with a dedicated CoreAudio driver, you 
should select this. Otherwise, use the built-in audio controller.
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Getting Help and 
Additional Info

 

If you pull down the Contacts menu in ReCycle, you will find some menu items 
that allow you to contact the manufacturers and get support:

 

!

 

For these items to be useful, you need to have a working Internet 

 

connection and an Internet browser installed on your computer.
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Go to the Propellerhead Homepage

 

This menu item brings you to the homepage of Propellerhead Software, 
where you will find information about possible new ReCycle versions, etc.

  

DDDD

 

Download Drum Loops

 

This menu item brings you directly to the Drum Loop page on the Propeller-
head web site. Here you can download various drum loops for free.
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ReCycle Tech Info and Support

 

This menu item brings you directly to the ReCycle Support pages on the 
Propellerhead web site. Use this option if you are having trouble with ReCy-
cle and need help!

  

DDDD

 

Order ReCycle Now

 

This takes you to the “Prop Shop” where you can place orders for all cool 
Propellerhead products.
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Register ReCycle Now

 

This is where you register your copy of ReCycle. Registering means that you 
get access to product updates (when available), tech support and more.
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Requirements

 

You can use ReCycle on any PC running Windows XP or Windows 2000. You 
also need a Windows compatible, 16-bit audio card.

 

Setting Up The Computer

 

Before proceeding, your computer should be set up and you should be reason-
ably familiar with its operation. You should also have the audio card installed and 
working properly.

  

DDDD

 

To check whether your audio card works properly, try playing back 
audio with the Media Player application (included with Windows).

 

!

 

The quality of the sound during direct playback from ReCycle de-
pends fully on the audio card. If you have a not-so-good audio card, 
this may mean that the sound quality during direct playback from 
the computer isn’t immaculate. However, this does not reflect the fi-
nal audio in exported or saved files, since these always maintain 

 

highest possible quality.

 

Finding your way on the 
ReCycle CD-ROM

 

Once you have turned on your system, insert the ReCycle CD-ROM and open it. 
At the root of the CD-ROM, you will find a file called “Read Me”. Double click 
this to get information about what is what on the CD-ROM.

 

Installing the Acrobat 
Reader

 

To be able to read the online documentation, you must have the Acrobat Reader 
application installed. If this isn’t already installed on your computer, you need to 
install it from the ReCycle CD-ROM:

 

1. Insert the ReCycle CD-ROM.

2. On the CD-ROM, open the folder “Acrobat Reader” and double click 
on the application file to install.

3. Follow the instructions in the dialogs that appear.
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Installing ReCycle

 

1. On the CD-ROM, double click the icon named “Install ReCycle“.

2. Follow the instructions in the dialog boxes that appear.

 

You will have the option to launch ReCycle directly when exiting the installer.

 

!

 

Don’t launch ReCycle yet! You need to perform some additional 

 

steps first: 

 

Read the Read Me file!

 

In the ReCycle folder that was created on your hard disk during installation, you 
may find a Read Me file. This will contain any late-breaking updates that didn’t 
make it into the manual. Please double click on it and read it before proceeding.

 

Register your software!

 

Please fill out and send in the registration card that comes in this package. Do-
ing so will make sure you are entitled to technical support and kept aware of up-
dates and other news regarding ReCycle.

 

Launching ReCycle

 

1. Locate the ReCycle entry on the Start menu and select it.

2. The program prompts you to insert the ReCycle CD-ROM (if not al-
ready in the drive).

 

This is only required the first time you run the program.

 

3. A dialog box appears, asking you to enter your name, company and 
serial number. Do so, and click OK.

 

The serial number is printed on the Registration Card which is included in 
the ReCycle package. Again, this procedure is only required the first time 
you run the program.

 

4. Finally, an Open dialog appears, asking you to locate an audio file 
for opening.

 

This is the same dialog that appears when you select “Open” in the program 
(see page 26). 
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Audio Settings

 

After launching ReCycle, you should open the Preferences dialog (Audio Page) 
on the Edit menu and check the Audio Card Driver settings.

 

The Audio Preferences with an ASIO driver selected.

 

Selecting an Audio Card Driver

 

The first thing to do is to select a driver for your audio card. All available drivers 
are listed on the Audio Card Driver pop-up menu. Select after the criteria listed 
below:
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If you are using audio hardware for which there is a specific ASIO 
driver, you should select this.

 

With an ASIO driver written specifically for the audio hardware, ReCycle can 
communicate more or less directly with the audio hardware. 

If you select an ASIO driver, some additional items will be available in the Audio 
Preferences:

  

DDDD

 

If the card and its driver supports it, the “Clock Source” pop-up al-
lows you to set an external source to which the audio playback can 
synchronize its sample rate.

 

Please refer to the documentation that came with your card for details.

  

DDDD

 

The ASIO Control Panel may contain settings specific to your audio 
card.

 

Please refer to the documentation that came with your card for details.

  

DDDD

 

If you have an audio card with multiple outputs, you can select 
which output pair you wish ReCycle to use by clicking the “Chan-
nels...” button.

 

This item will not be selectable if you use a card with only a regular stereo 
output.

  

DDDD

 

If there is no specific ASIO driver, you should select the Direct 
Sound driver for the audio hardware.

 

This makes ReCycle communicate with the hardware via Direct Sound (a 
part of the Microsoft DirectX package). For this to be possible, you need to 
have DirectX installed on your computer, and there must be a Direct Sound 
driver for the audio hardware. The Audio Preferences dialog changes ap-
pearance if a Direct Sound (or MME) driver is selected.

 

The Direct Sound driver for a soundcard selected.

  

DDDD

 

If the audio hardware doesn’t support Direct Sound (i.e. there is no 
Direct Sound driver for the audio hardware), select the MME driver 
for the audio hardware.

 

This makes use of Windows Multimedia Extensions, the part of Windows 
that handles audio, MIDI, etc. Using MME may result in a noticeable 

 

latency, 

 

causing the audio playback to be slightly delayed. In the case of ReCycle, 
you would notice this in that playback started slightly after you clicked the 
Play button, for example.
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Regardless of which type of audio hardware or drivers you are using, you should 
follow these basic steps:

 

1. Make sure you have the latest drivers for the audio hardware! 

 

Please check the manufacturer’s website for the latest versions.

 

2. Install the audio hardware and its drivers as described in its docu-
mentation.

3. Connect the stereo outputs of your audio hardware to your listening 
equipment (speakers, mixer, headphones or similar).

4. If possible, test that audio plays back properly with the audio hard-
ware.

 

In the case of audio hardware with ASIO drivers, you will need some test ap-
plication for this (often included with the audio hardware). If you are using Di-
rectX or MME drivers, you can use Windows’ Media Player application for 
this.

 

Setting the Audio Card Buffer 

 

ASIO

 

If an ASIO driver is selected, the “Buffer Size” slider in the Preferences dialog 
will be grayed out.

  

DDDD

 

If you are using an ASIO driver specifically written for the audio 
hardware, you can in some cases make settings for the hardware by 
clicking the Control Panel button.

 

This opens the hardware’s ASIO Device Control Panel, which may or may 
not contain parameters for adjusting the number and/or size of the audio 
buffers - the fewer and smaller the audio buffers, the lower the latency. 
Please consult the documentation of your audio hardware and its ASIO driv-
ers for details!

 

DX/MME

 

For DirectX or MME drivers, it is important that you trim the buffer setting prop-
erly. The buffer setting is a balance between fast response to playback com-
mands on one hand and “safe” audio playback on the other.

 

1. Select “Open” from the File menu.

2. In the dialog that appears, navigate to the ReCycle program folder.

 

Make sure the “All Files” option is selected on the “Files of type” pop-up 
menu.

 

3. Open the file “Drum Tools Demo.aif”.

4. Activate Playback by clicking the Play button.

5. Open the Preferences dialog from the Edit menu and select the Au-
dio page.

6. In the Audio Preferences dialog, locate the Buffer Size slider and 
drag it all the way to the right.

 

The Buffer Size slider.

 

7. Now drag the Buffer Size slider to the left, a bit at a time. Try posi-
tions further and further to the left, until the sound starts ”breaking 
up”.

8. Drag the slider a little bit to the right, so that the sound is OK again.

9. Close the dialog.

 

You are now finished with your audio settings for ReCycle. The settings you just 
made are stored automatically.
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Getting Help and 
Additional Info

 

If you pull down the Help menu in ReCycle, you will find menu items for getting 
help, support and information:

 

Help Contents
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If you select “Contents” the Help Contents appears. The on-line 
help contains descriptions of all menu items, allowing you to 
quickly find the desired item.

 

You can also perform a keyword search.

  

DDDD

 

You can also get help by clicking the Help button or [F1] in ReCycle 
dialogs to get specific information about each dialog. 

  

DDDD

 

Pressing [F1] (with no dialog open) will launch help for the main 
ReCycle Window where you can click on the item or section you 
want to know more about.

 

Contacts

 

The next items on the Help menu allow you to contact Propellerhead Software 
for support and more info.

 

!

 

For these items to be useful, you need to have a valid Internet con-

 

nection and an Internet browser installed on your computer.

  

DDDD Go to the Propellerhead Homepage...
This menu item brings you to the homepage of Propellerhead Software, 
where you will find information about possible new ReCycle versions, etc.

DDDD Download Drum Loops...
This menu item brings you directly to the Drum Loop page on the Propeller-
head web site. Here you can download various drum loops for free.

DDDD ReCycle Tech Info and Support...
This menu item brings you directly to the ReCycle Support pages on the 
Propellerhead web site. Use this option if you are having trouble with ReCy-
cle and need help!

DDDD Order ReCycle Now
This takes you to the “Prop Shop” where you can place orders for all cool 
Propellerhead products.

DDDD Register ReCycle Now
This is where you register your copy of ReCycle. Registering means that you 
get access to product updates (when available), tech support and more.

About ReCycle
Selecting this item brings up a dialog listing the fine people involved in creating 
this program.



4 DDDD    Quick Tour of ReCycle



QUICK TOUR OF RECYCLE20

How ReCycle Works
There are many things you can do with ReCycle. But the most common applica-
tion is to slice a loop for tempo changes or editing. These are the basic steps 
(details follow later in this chapter):

1. Use the Open dialog to locate and open the loop audio file.
The program now analyses the loop and detects the individual “hits” or 
“sounds” in it. It then displays the loop in the waveform display. 

2. The second step is to work with the Sensitivity slider and the tools 
to set up a number of slices.
Each slice represents an individual sound in the loop. Slices are displayed 
as vertical lines across the waveform.

3. The slices are now used for setting up loop points using the left and 
right locators. Play back the audio to check that the loop is correct.
The loop settings are used by ReCycle to calculate the tempo of the sam-
pled loop, among other things.

4. Once you have set the loop points, you can enter the length of the 
loop in Bars/Beats, and change the Time Signature if required. 
Finish by pressing [Return], and the original tempo will be calculated and 
displayed on the toolbar according to the settings made.

5. Now you can enter Preview mode, and change the tempo and pitch 
independently, add processing and much more.
Everything you do in Preview mode will be present in the resulting REX2 file 
- what you hear is what you get.

Once you have tweaked the loop to your liking in Preview mode it’s time to put 
the loop to use.

Using the Loop in another Program

1. Save the Loop.
This operation produces a REX2 file, the native file format used by ReCycle. 
REX2 files contains both the audio data of the loop, the slice information and 
the original (calculated) tempo.

2. Launch the program (Reason for example), and import the REX2 file 
onto an Audio Track.
The slices will now appear in their correct order and positions, and you will 
be able to change tempo and manipulate the slices.

On the following pages you will find a quick tutorial. After this are handling in-
structions for all different aspects of the program. In the chapter “Example Appli-
cations” you will find more practical examples of what you can do with ReCycle.

About ReCycle and Reason

Reason, another program by Propellerhead Software, features a dedicated Re-
Cycle file player (Dr. REX). In addition to playing back ReCycle files, Dr. REX al-
lows you to further process files with various synth parameters, to change the 
pitch of individual slices and much more. The Reason sequencer also has a sep-
arate REX editor for editing slices.

! The handling of REX2 files in the included program Reason 
Adapted for ReCycle is described in the ReCycle + Reason Quick 
Start Guide.
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Using ReCycle - Step By 
Step
The text below assumes that you have installed ReCycle and a REX2 compatible 
sequencer program such as Reason or Cubase. If not, please see the Installa-
tion chapter for more information.

1. Launch ReCycle.
The Open dialog appears.

2. Locate the file called “Drum Tools Demo.aif” in your ReCycle folder.

3. Select the file and click Open.
You will be asked whether you want the Left Locator to be moved to the first 
Slice point (see page 28 for more info). Click Yes. Next a window appears 
stating that you cannot hear the effects yet. Again click Yes.

The Drum Tools Demo loop.

4. In the window, click the Play button.
You should now hear the entire loop, from start to end, repeating until you 
click the Stop button. As you can hear, the Drum Tools Demo loop has “dou-
ble” downbeats, it starts on a downbeat, and ends on a downbeat, which 
means that two downbeats are played in succession when the file is looped. 
We shall fix this shortly - but for now let’s proceed.

5. Drag the Sensitivity slider to the right, until its value is between 70 
and 80 and a number of lines appear.
We call those lines and their triangle symbols “slices” since they indicate 
that the sound has now been cut up into slices.

The Sensitivity Slider and some slices.

6. Position the mouse pointer over the “L” handle (the Left Locator) 
and drag it to the left a bit and release it.
As you will see, it winds up exactly on one of the slices, and on the next lap, 
playback starts from this point. 

Stop Play
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7. Drag the Left and Right Locators until the loop is exactly 1 bar long.
The left locator should be positioned at the start of the loop, on the first slice 
marker, and the right locator should positioned on the last slice marker. This 
last slice contains the “extra” downbeat (see step 4), but as the Right Loca-
tor position governs when the loop should jump back to the Left Locator, this 
second downbeat won’t be played, and the loop will now be exactly 1 bar.

8. With playback turned off, move the pointer over the waveform view.
The pointer changes to a speaker symbol.

9. Click with the Speaker pointer on the slices in the waveform view.
You will hear each individual sound in the loop. The slice you clicked last is indi-
cated by a dotted vertical line to the left - this slice is called the Current Slice. 
You can also drag the pointer over the slices with the mouse button pressed to 
audition the sounds in the loop.

10. Click in the “Bars” field, type “1”, and hit [Return].
The calculated tempo is now shown as the “Orig. Tempo” on the Toolbar.

The Bars/Beats settings, the (calculated) Original Tempo and the Preview Tempo field.

11. Click on the Preview Toggle button.
Preview mode is now activated.

Now you can make various settings to the loop, and hear the results in real-time. 
Preview mode lets you hear exactly how the loop will sound after being saved as 
a file:

DDDD By adjusting the Preview Tempo knob or typing in a new tempo di-
rectly in the Preview Tempo field, you can change the tempo of the 
loop.
If you intend to play back the loop as a REX2 file in a sequencer, the loop will 
follow the tempo setting of the sequencer, regardless of this setting!

DDDD By adjusting the Pitch knob you can change the pitch of the loop.

DDDD There is a Gate function which can be used to remove all sound in a 
loop that falls below a set threshold. 
This is described on page 56.

DDDD In addition there are three effect processors; Envelope, EQ and 
Transient Shaper, that allow you to further tweak the sound of the 
loop before exporting/saving it as a file.
The processors are described in the chapter “Processing Audio”.

So, now we have everything we need, a perfect loop, a tempo, possibly some 
audio processing parameters, and a good set of slices. You could at this point 
simply save the sliced-up loop as a REX2 file and import this file into a compati-
ble program. 

✪ There is an additional ReCycle tutorial in the ReCycle + Reason 
Quick Start Guide. This is based on a different audio file and pro-
vides some extra tips on how to correctly slice up a file.

The Locators set up correctly.
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Exporting to File
Besides creating REX2 files for use in audio sequencers, ReCycle can be used 
to simply change the inherent properties of a file, like the tempo and/or the pitch 
for example. You can then export the loop (as one sample - not as separate 
slices) and use it in any audio application or software sampler. 

A typical example would be a situation where you have found a perfect loop you 
wish to use in a song you have recorded. The problem is that the tempo of the 
loop is wrong, and you don’t wish to change the tempo of the song to accommo-
date the loop, Let’s further assume that the song has been recorded using a 
hard disk recording system that cannot import REX2 files, and you don’t have a 
sampler.

The simple answer is if the loop you want to use can be opened in ReCycle, you 
don’t have a problem! Proceed as follows: 

1. Open the file in ReCycle and use the normal techniques to add an 
appropriate amount of slices, set the number of Bars and Beats etc. 
(to calculate the original tempo) and then enter Preview mode.
Note that even though you will export the file as one sample, you still have to 
slice the file! 

2. In Preview mode, simply type in the Preview Tempo to match the 
song tempo, and/or change the pitch to fit the song.
Naturally, you can also add equalization, or any of the other Effects or pro-
cessing functions if you like.

3. Activate “Export as One Sample” on the Process menu.

4. Use the Export File dialog (see page 59) to save the file in it’s origi-
nal format.
The resultant file will now match the songs tempo and/or pitch perfectly!

Congratulations! You just tried out some of the basic capabilities of your new 
program! Of course, there’s a lot more to learn and discover. Please proceed to 
the following chapters to find out about all the capabilities of this amazing pro-
gram!
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About Sounds and 
Memory
Whenever ReCycle displays audio in a window, it has to load it into the com-
puter’s RAM memory. 

How much audio you can load into the program at one time depends on how 
much memory you have in your computer (total) and how much of it that other 
programs are currently using. If the program tells you there is not enough mem-
ory for a certain operation, or if you can’t open an audio file (in any of the sup-
ported formats), the first thing to try is to quit other programs.

You can open files (mono or stereo) that are up to five minutes in length. To 
open a five minute stereo file ReCycle has to have access to 52 MByte of RAM. 

About REX2 Files

REX2 is the native file format of ReCycle. Saving a file in this format will signifi-
cantly reduce the size of the file. This is achieved by applying a compression al-
gorithm to the file when saved. The compression is “non-lossy” meaning that it 
does not compromise the audio quality in any way. How much the file will be 
compressed compared to the original size depends on the complexity of the au-
dio and other factors. When you open a REX2 file, the file information in the 
Open dialog will tell you how much the size has been reduced, expressed as a 
ratio (see page 27).

Using Open

The Open dialog.

The Open item on the File menu is used to load audio files from the hard disk.

The dialog box is a standard file dialog with some additions.
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File Information
When you select a file in the list, information about file type, length, etc. is shown 
in the lower part of the Open dialog.

The File information.

For all recognized audio file formats, the following information is displayed:

• File Type (see “File Formats” next page).
• Number of channels.
• File Length.
• Bit depth.
• Sample Frequency.
• File Size, in Bytes (For REX2 files the data compression ratio is displayed in 

parentheses. In the picture above, 2.4:1 means that the file was 2.4 times 
larger before it was compressed).

If the file is a ReCycle file, the following additional information is displayed:

• Tempo.
• Time signature.
• Length in bars and beats.
• Usage, which tells you the size of the loop (i.e the audio between the loca-

tors) in relation to the total file size in percent.
• The number of slices in the file (only available if a REX2 file is selected).
• Export Size tells you the size of the file if exported (only available if a REX2 

file is selected).

Play and Stop buttons

When you click the Play button, the selected file will be played back looped until 
you press Stop. 

Auto Play

If this option is on (ticked), playback will start automatically as soon as a new file 
is selected from the dialog. If a new file is selected during playback, the previous 
selection will stop and playback of the new selection will start directly.

You will not be able to play a file under the following conditions:

• If the file is in a format ReCycle doesn’t support.
• If there isn’t enough memory (RAM) left to load the sample.
• If the sample is longer than 30 seconds, the Auto Play function will not work 

- you can, however, audition it using Play.

File Type Selector (Windows only)

DDDD When the last item on this menu is selected, the file list will show 
all files in the directory that are in any of the formats that ReCycle 
supports.

DDDD When any of the other alternatives are selected, the files list only 
shows files in that format.

About The Different File Formats

ReCycle can load mono or stereo files that meet the following criteria:

• The bit depth can be 8, 16 or 24 bits.
• Sample rates between 11.025 kHz to 1.0 MHz are supported.
• The file is not longer than 5 minutes (regardless of sample rate and mono/

stereo status).
The table below shows the supported file formats.

In addition, the Macintosh version of ReCycle supports the following format:

| Name | Extension | Comment

ReCycle RX2/RCY/
REX

REX2 (*.rx2) is the native file format created when 
you save in ReCycle. RCY/REX are ReCycle files 
that were created with previous versions of ReCy-
cle.

Wave WAV The standard Microsoft file format for audio. May be 
stereo or mono or in formats other than 16-bits.

Audio IFF
(AIFF)

AIF Audio Interchange File Format; Apple’s standard 
audio file format. May be stereo or mono or in for-
mats other than 16-bits.

| Name | Extension | Comment

Sound 
Designer II

SD2 The current Digidesign file format. May 
be stereo or mono and at least 16 bits. 
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About Split Stereo Files

ReCycle can load Split stereo files (commonly used in Logic and Pro Tools). 
Split stereo files have the extension “L” or “R”. If you load a file with one of these 
extensions, ReCycle will automatically scan for an opposite match and load this 
at the same time. For the match to work, the split files have to have the same 
name (apart from the extension), size, bit rate and be located in the same folder.

Using Drag and Drop
ReCycle supports standard Drag and Drop. Proceed as follows:

1. In the Finder/Explorer, locate an audio file in one of the supported 
file formats.

2. Drag this file and drop it on the ReCycle icon.
If the program is already running, the file appears in a new window. If it isn’t, 
ReCycle launches and the file opens.

Launching from Files
DDDD Any files created by ReCycle will open in ReCycle if you double click 

on them. 

DDDD In addition, (Windows only) you can open “WAV” or “AIF” files in 
ReCycle by right-clicking on them in the Explorer, and selecting 
“Edit with ReCycle” from the pop-up menu that appears.
If you chose to associate “WAV” or “AIF” file formats with ReCycle during 
the installation, you can open these files in ReCycle by double clicking, just 
as with ReCycle files.

If the “Do you want to move the left locator...” dialog appears

If you Open or Receive a sample, and there is no loop setting, or the loop start is 
just at the beginning of the sample, a dialog appears suggesting you should let 
the program move the Left Locator to the first slice point. This is to avoid very 
short slices at the beginning of the sample. We recommend that you click “Yes” 
unless you have good reason. 

DDDD If you want this to be done automatically, open the Preferences - 
General dialog on the Edit menu and activate the option “Always 
Move Left Locator to First Slice Point”.
When this is activated, ReCycle will automatically place the Left Locator on 
the first slice point when you Open or Receive a sample, without asking.

See page 49 for more information on setting Locators.
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Window Overview
Tool Bar
The left half of the Toolbar contains the following items:

The right half of the Toolbar contains the following items:

Waveform Display

Export as One Sample

Slice Audition buttonsEffect buttons

Preview toggle

Sensitivity slider

Stop

Play

Tools

Open/Save

Silence Selected

Gate 
Sensitivity

Export Sound

Length settings

Preview Tempo setting 
and Original Tempo

Preview Pitch Processing Gain

Time Signature Left Locator

Horizontal Magnification

Slice Marker

Waveform

Thumbnail overview

Right Locator

Level meter

Vertical MagnificationSlice Marker Handle
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Status Bar
The Status Bar is located at the bottom of the ReCycle window. 

The leftmost area of the Status Bar displays the following:

DDDD If you point anywhere on the Toolbar, this area will display “ex-
tended” tooltips and, if applicable, keyboard shortcuts in parenthe-
ses for any Toolbar item you point to. 
This area says “Ready” if you are not pointing at any item.

Left corner of the Status Bar (while pointing at the Sensitivity Slider).

DDDD Pointing in the waveform display will show the position (in seconds 
or samples depending on the Preferences setting). 

In addition, the Status Bar always displays the following properties regarding the 
currently selected file in the right half of the Status Bar:

• Stereo/Mono status of the file.
• The sample rate at which the file was recorded.
• The number of slices between the locators.
• The length of the file in seconds.
• The size of the exported data in bytes.

Right corner of the Status Bar.

Window Title

The window title displays two things:

• The name of the file.
• An asterisk that indicates if the file hasn’t been saved yet.

Toolbox

The Toolbox is located in the upper left corner of the toolbar. You select a tool 
from the Toolbox by clicking on its icon. Below follows a brief description of 
what the tools do. Detailed applications follow later in this chapter and in the fol-
lowing chapters.

Level Meter

The level meter indicates the output level of the selected file during playback. 
Two meter bars are shown for stereo files and one bar for mono files.

You should check that levels never cause the Clip indicator(s) at the top of the 
meter to light up. 

• If Preview mode is selected, the meters indicate the level, post any applied 
effects.

• You can boost or cut the level with the “Gain” parameter in Preview mode.

In case of boosting the output level, watch the meter (and listen) carefully to 
avoid clipping.

| Tool | Description

Arrow Used for selecting Slice markers by clicking on their handles.

Mute Used for muting slices by clicking on their handles.

Lock Used for locking slices, by clicking on their handles.

Pencil This is used for adding slices manually.

Clip indicators
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Handling Windows
You can open as many loops as RAM permits, and they will each appear in a 
window.

• For more information about window handling, see the documentation that 
came with your computer.

• ReCycle’s Windows menu contains a list of the currently open windows. Se-
lecting one makes it active.

• The Close item on the File menu closes the active window.

Magnification, Song 
Position and Scrolling
The Horizontal Magnification Indicator

If you click or drag in the horizontal magnification indicator, the amount of hori-
zontal zoom changes. Furthermore, the indicator will always show the current 
magnification.

The Vertical Magnification Indicator

If you click or drag in the vertical magnification indicator, the amount of vertical 
zoom changes. The vertical scale is displayed in decibel, and the zoom factor 
changes in steps of 6 dB. Minimum zoom will show 0 dB as the top and bottom 
waveform amplitude boundaries in the window, the next factor will show -6, and 
so on. 

Using The Magnifying Glass

Zooming in

1. Hold down [Command] (Mac OS) / [Ctrl] (Windows).

2. Move the mouse over the waveform area.
The pointer turns into a magnifying glass.

DDDD Click once in the waveform.
The view is zoomed in one step. The position you clicked at will be centred in 
the window.

Zooming out

DDDD Zooming out is done the same way as zooming in, except you also 
hold down the [Option] (Mac OS) / [Alt] (Windows) key.

The Zoom in and zoom out tools.

Using a Zoom rectangle

To select a certain area to zoom in on, proceed as follows:

1. Hold down [Command] (Mac OS) / [Ctrl] (Windows) and press and 
hold the mouse button in the waveform display.

2. Drag to make up a selection rectangle.
The area inside the rectangle becomes dark.

3. Release the mouse button.
The selected area will now fill the entire window.

Zooming in on a certain area.
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Magnifying using the Thumbnail Overview
DDDD The method of making up a rectangle with the [Command] key (Mac 

OS) / [Control] key (Windows), described above, can also be used 
in the thumbnail overview.
This changes the zoom factor of the main waveform, not of the thumbnail it-
self.

Zooming in using the thumbnail.

Scrolling using the Thumbnail
When zoomed in on the waveform, the Thumbnail Overview will display a dark 
rectangular area indicating which part of the waveform is now shown in the main 
waveform display. This rectangle can be dragged sideways, which scrolls the 
waveform display. You can also click anywhere in the Thumbnail Overview to 
move the rectangle to that position.

Dragging the Thumbnail rectangle.

The Scroll Bar
The scroll bar can be used to scroll the view of the waveform.

Waveform Display 
Options
You can customize the look of the Waveform window by using the settings in 
the lower half of the Preferences - General dialog:

The “View stereo files as sum of L+R” Option

To make the size of stereo files in the ReCycle window more compact, the left 
and right channels of stereo files can be summed to one channel, instead of be-
ing stacked on top of each other. Note that this is a display option only, the ac-
tual audio material is not affected in any way.

Waveform Look

Use this pop-up menu to select one of three different waveform "looks"; Plain, 
3D or Shaded. Plain displays the waveform with normal graphics, 3D adds a 
depth effect to the graphics and Shaded adds a progressive shade to the lower 
part of the waveform.

Waveform Color

Click this button to select a new color for the waveform. On the Macintosh, this 
brings up the standard Apple Color Picker, under Windows this brings up the 
standard Windows Color dialog. The color field to the right shows you the cur-
rent color selection.

Contrast Slider

This slider sets the amount of contrast between the background display and the 
waveform. For maximum contrast, position the slider all the way to the right. Mov-
ing the slider to the left progressively adds more of the chosen waveform color 
to the background display.
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The View Menu
The View menu features the following items that relate to how the waveform is 
displayed:

Magnify to Fit/Magnify to fit Loop
If you select Magnify to Fit from the View menu, the display will zoom out so that 
the entire sample fits the window. If Magnify to Fit Loop is selected, the display 
will zoom in (or out) so that the area between the left and right locators will fit the 
window.

Jump to Cursor
If this is selected, the window will scroll to the current play position, maintaining 
the current magnification factor.

Show Grid
You must have set a loop length for this item to be available. When enabled, a 
grid showing Bars/Beats/16th notes is shown in the display.

Scroll during Playback
When you play back, the current position is indicated by a dotted line travelling 
across the waveform. If the option "Scroll during Playback" is checked on the 
View menu, the current position will always be displayed in the waveform dis-
play. This option can also be toggled on or off by pressing [F] on your computer 
keyboard. A rectangle in the thumbnail overview indicates which area of the 
waveform is currently displayed in the waveform display.

The thumbnail overview shows you which part of the waveform is displayed.

The Edit Menu
The Edit menu features the following items:

• You can use “Copy Loop” to copy the entire loop (i.e. all waveform data be-
tween the left and right locators) to the clipboard. 

• If the clipboard contains data, this can be pasted into a new (automatically 
created) document window by using the “Paste as New Document” menu 
item.

• “Delete” can be used to delete selected slice markers.
Select All and Invert Selection are explained on page 47.

Undo/Redo
Virtually all actions in ReCycle 2.1 can be undone. You can undo up to 10 ac-
tions.

DDDD To undo the latest action, select “Undo” from the Edit menu or 
press [Command] (Mac)/[Ctrl] (Win)-[Z].
The action to be undone is indicated next to the Undo command on the Edit 
menu.

DDDD If you wish to “Undo the Undo”, this is possible since after an Undo, 
this menu command changes to “Redo”. 

(the default key command for Undo). The menu item also gives you a clue about 
what will be undone. For example: If it says “Undo Delete Slice(s)” the last thing 
you did was deleting a slice.

About Multiple Undo

The concept of multiple undo may require an explanation: You can undo up to 
10 actions, or in other words, ReCycle 2.1 has an Undo History with up to ten 
steps.

Let’s say you have performed the following actions:

1. Changed the Stretch setting. 

2. Muted a slice with the Mute tool.

3. Raised the Sensitivity Slider setting.

4. Locked a slice with the Lock tool.

5. Changed the tempo.
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After these five actions, the Undo History will look as follows:

If you now select Undo, your latest action (the tempo change) will be undone, 
and moved to a “Redo list”:

Selecting Undo again undoes the next action in the list (the panning adjust-
ment):

If you now select Redo, the last undone action will be redone. In this case, your 
panning adjustment will be performed again (and added to the Undo History 
again):

At this point, you still have the option to Redo the tempo change. But if you in-
stead would perform another action (e.g. changed the Envelope Decay), this 
would become the action at the top of the Undo History - and the Redo list 
would be cleared.

Now you can no longer redo the undone tempo change!

5. Adjust Tempo

4. Lock Slice

3. Change Sensitivity

2. Mute Slice

1. Change Stretch

UNDO

4. Lock Slice

3. Change Sensitivity

2. Mute Slice

1. Change Stretch

UNDO

5. Adjust Tempo

REDO

4. Lock Slice

3. Change Sensitivity

2. Mute Slice

1. Change Stretch

UNDO

5. Adjust Tempo

REDO

UNDO

5. Adjust Tempo

REDO

4. Lock Slice

4. Lock Slice

3. Change Sensitivity

2. Mute Slice

1. Change Stretch

4. Lock Slice

3. Change Sensitivity

2. Mute Slice

1. Change Stretch

UNDO REDO

(empty)

5. Change Envelope Decay
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Context Menu Items
Right-clicking (Windows) or [Ctrl]-clicking (Mac OS) in different areas of the 
waveform display will bring up context-sensitive menus. The context menus will 
contain various items also found on the Edit and View menus, but there are 
some additional items that are only available via context menus. 

Main Waveform Display

The highlighted area indicates the main waveform area.

By right-clicking (Windows) or [Ctrl]-clicking (Mac OS) in the main area of the 
Waveform display brings up a context menu with the following items:

Slice Marker Strip

The highlighted area indicates the Marker strip area.

Right-clicking (Windows) or [Ctrl]-clicking (Mac OS) in the marker strip (but not 
directly on a slice marker handle), brings up a context menu with the following 
items:

| Menu Item | Description

Copy Loop See “The Edit Menu” above.

Set Left Locator to This Slice The Left Locator will be placed at the begin-
ning of the slice you clicked on.

Set Right Locator to This Slice The Right Locator will be placed at the end of 
the slice you clicked on. 

Set Loop Around This Slice The left and right locators will be placed at 
the start and end of the slice you clicked on, 
respectively. 

Jump to Cursor See “The View Menu” above.

Magnify to Fit/Magnify to Fit 
Loop

See “The View Menu” above.

Magnify to Fit Slice This will zoom the display so that a single 
slice (the slice you clicked on) will fit the win-
dow.

| Menu Item | Description

Select All This will select all slices. See page 47.

Invert Selection See page 47.

Magnify to Fit/Magnify to Fit 
Loop

See “The View Menu” above.
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Slice Handles
Right-clicking (Windows) or [Ctrl]-clicking (Mac OS) directly on a slice handle, 
brings up a context menu with the following items:

Left/Right Locator Area

The highlighted area indicates the Locator area.

By right-clicking (Windows) or [Ctrl]-clicking (Mac OS) in the Locator Area, the 
“Magnify to Fit/Magnify to Fit Loop” menu items are available.

| Menu Item | Description

Locked Toggles the “Locked” status on or off for the 
slice handle you click on. See page 46.

Muted Toggles the mute/unmute status for the slice 
handle you click on. See page 44.

Delete This will delete any selected slice(s). See 
page 48.

Select All This will select all slices. See page 47.

Invert Selection See page 47.

Set Left Locator to 
This Slice

This sets the left locator to the slice handle 
you click on. 

Set Right Locator to 
This Slice

This sets the right locator to the slice handle 
you click on. 

Magnify to Fit/Magnify to Fit 
Loop

See “The View Menu” above.
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Audio Quality
ReCycle plays back audio directly from your computer, using the sound capabil-
ities of your specific computer (see the Installation chapters for more details). 

Playing the entire Loop
To play the entire loop, press [Enter] on the numeric keypad or click the Play but-
ton.

The Play Button

To stop playback, press [0] on the numeric keypad or click the Stop button.

The Stop Button

In addition, you can toggle between Play and Stop modes by pressing [Space].

Auditioning Slices
There are three methods you can use to audition Slices:

DDDD Using the mouse
When you move the mouse over the waveform area, the pointer turns into a 
speaker icon. When you click with the speaker tool on a Slice (a section of 
waveform between two Slice markers), it plays back. Press [Space] to stop 
(even if you don’t, playback automatically stops at the end of the Slice). If 
you click and drag left or right you can audition consecutive slices. (Dragging 
to the left will not play slices “backwards” -  it only reverses the order that  
the slices are played back in.) 

DDDD The “hot-spot” (the part of the pointer that you aim with) is indi-
cated by a cross. 

DDDD Using the Slice Audition buttons
The three Slice audition buttons are located to the right beside the Play and 
Stop buttons. They have the following respective functionality: 

Play previous Slice (and make it the current). By repeatedly clicking 
this button, you can step through the Slices in reverse order and au-
dition each one.

Play current Slice.

Play Slice and move to next (making the next Slice the current). By 
repeatedly clicking this button, you can step through the Slices from 
left to right and audition each one.

The “hot-spot”.
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The current Slice is indicated in the ReCycle window by a dotted vertical Slice 
marker.

DDDD Using the numeric keypad
The keys [7], [8] and [9] on the numeric keypad has the same functionality 
as the corresponding three Slice audition buttons. Pressing [7] plays the 
previous Slice, pressing [8] plays the current Slice and pressing [9] plays 
the (current) Slice and moves to the next.

Moving the current Slice marker 
You can also use the numeric keypad to move the current slice marker position 
without auditioning:

DDDD Press [4] to move the current slice marker to the previous slice 
marker.

DDDD Press [6] to move the current slice marker to the next slice marker.

DDDD Press [1] or [2] to move the current slice marker to the Left/Right 
Locator respectively.

Preview mode
The Preview function lets you audition the loop exactly as it will sound when 
saved as a file. In Preview mode you can change the pitch or tempo indepen-
dently from each other, change the gain of the loop, add processing and more. 
Note that all Preview settings will be applied to the resulting saved or exported 
file!

! To audition non-REX2 files in Preview mode, you have to first spec-
ify the loop length (in Bars and Beats) to calculate the tempo, cre-
ate a sufficient amount of slices, before enabling Preview mode. 
How to specify loop length and how to set slices is explained in the 
next chapter “Setting Slices and Loops”.

Preview Tutorial

! Preview processing features are more fully described in the chapter 
“Processing Audio”.

To try out some of the Preview features, use the supplied “Tutorial.rx2” file. This 
loop already has correct slice, length and tempo settings, so that you can use 
Preview mode straight away. Proceed as follows:

1. Locate the file “Tutorial.rx2” inside the ReCycle folder, and open it.
The Original Tempo field displays the original tempo of the loop, that was 
calculated in ReCycle before it was saved as a REX2 file. The Tempo field 
displays the current tempo.

2. When the file is loaded, click the Preview button.
The button becomes dark, indicating Preview mode. The previously “greyed 
out” parameter knobs on the Toolbar now become active.

The Preview Toggle button.

3. Start playback using the Play button.

DDDD Try changing the tempo of the loop using the Tempo knob.
Hold down [Command] (Mac) / [Ctrl] (Win) and click the Tempo knob to re-
set the tempo back to the original.

DDDD Try changing the pitch of the loop using the Pitch knob.
You can change the pitch up or down two octaves (+/- 24 semitones). Hold 
down [Command] (Mac) / [Ctrl] (Win) and click the Tempo knob to reset the 
pitch back to the original. 

The current Slice
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4. Click the Envelope button, or select “Envelope” from the View 
menu.
The Envelope panel appears below the main toolbar. Envelope allows you to 
adjust three parameters; Attack, Decay and Stretch (see the chapter “Pro-
cessing Audio” for a full description of the Envelope parameters). This par-
ticular file was saved with non-default Attack and Decay parameter settings, 
which means that the Envelope effect is already turned on. This is indicated 
by the darkened and lit On/Off button (the leftmost button on the panel).

5. Turn the “Stretch” knob fully to the left (0%).

6. Now lower the tempo of the loop down to about 70 bpm and start 
playback.
As you can hear, at this tempo the slices sound “chopped off”, with a dis-
cernible gap of silence between each slice. 

7. While still in playback, gradually turn the Stretch knob clockwise 
until it is set to about 45%.
Like magic, the tail (end) portion of each slice is lengthened so that the gaps 
disappear. The Stretch function actually generates sound. It analyzes the ex-
isting tail of each slice, and then lengthens it. This feature is used if you wish 
to lower the tempo of a loop.

DDDD There are two other effect processors which can be applied in Pre-
view mode, “Transient Shaper” (compressor) and “Equalizer”.
These are described in the “Processing Audio” chapter.

! For all Preview settings, the principle “what you hear is what you 
get” applies to the resulting saved or exported file!
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Using Sensitivity
Most of the time when working with ReCycle, you will want to cut your loop up 
into slices. A slice is a section of the waveform, from one slice marker to the next.

When you load or receive a loop, ReCycle analyzes it to determine where slice 
markers should appear (where the individual sounds in the loop are).

The Sensitivity slider is then used by you, to set the overall amount of slices. The 
higher the sensitivity, the more slices you will get. And, the more slices you have, 
the smaller entities ReCycle will cut the loop into, when you save it. For more in-
formation, see page 49.

The number to the right of the slider represents the current position of the slider, 
where 0 represents minimum sensitivity and 99 maximum sensitivity.

As described below, the quickest way to get a good selection of slices is to set 
the sensitivity quite high, roughly between 70 - 80, and then use the Mute Tool 
to deactivate any slices you don’t need (see later in this chapter for details on 
the Mute Tool).

Setting Sensitivity using the Keyboard
DDDD You can type a number on the typewriter part of the keyboard, di-

rectly.
This can be used to quickly give the slider a rough setting. If you hit “1” it 
gets set to “11", if you press “2” it gets set to “22” etc.

DDDD You can use the [+] and [–] keys to “nudge” the slider up and down.

About Stereo and Mono
For stereo files, ReCycle analyzes both channels for slice points. In all respects, 
the methods you can use and other considerations are the same regardless 
whether the audio is in stereo or mono. 

Slices always cut across both channels at the same position in the waveform, 
they are not channel independent.

Using the Mute tool
You might run into situations where there are too many slices on the screen. You 
could of course reduce the Sensitivity to get rid of the slice markers you don’t 
want, but then other slice markers could disappear too, and this might not be de-
sirable. What you need to do in a situation like this is to “mute” an individual 
slice, and this is just what the Mute Tool lets you do: When you select the Mute 
Tool and click on a slice marker it gets diminished and its line disappears.

Before and after Muting a slice marker.

To try the effect of Muting, proceed as follows:

1. Click on two adjacent slices which play one sound each.

2. Mute the marker that divides the two slices.

3. Click again to audition.
You will hear that what was previously two slices is now one.

A slice marker

A slice
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Muting several Slices at the same Time
If you have several slices selected (see below) they will all get muted when you 
click on one of them.

Clicking on one of the selected slices...

... mutes all of them.

Unmuting Slices
To “re-activate” a muted Slice, simply click on it again with the Mute tool.

When do I use the Mute tool?
Use the Mute tool when you have a situation like the one below:

In the example above, the Sensitivity slider had to be set to a fairly high value to 
get the number of slices you see. But raising Sensitivity led to one unwanted 
slice, splitting a sound in two. Muting is the solution.

After muting the unwanted slice.

How do I find unwanted Slices?
Our most important tip is this: Always audition each slice to hear what they actu-
ally play. Try stepping through the loop with the “Play Slice and Move to Next” 
button, and adjust the Slices until you hear them the way you want them.

Another good practice is to increase magnification slightly and scroll through the 
slices to look for sounds that have been split unnecessarily. 

For optimal results, combine the two techniques above.

This slice is probably not 
wanted.
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Using the Lock Tool
The Lock tool is essentially the opposite of the Mute tool. If you lock a slice, by 
clicking on its marker with the Lock tool, it will stay even if you drag the Sensitiv-
ity slider all the way to zero.

If a slice is locked...

...it will stay even if you set Sensitivity to zero.

Locking several Slices at the same time
If you have several slices selected (see below) they will all get locked when you 
click on one of them.

Unlocking Slices
To unlock a locked Slice, simply click on it again with the Lock tool.

When do I use the Lock tool?
If you got a good set of slices by just using the Sensitivity slider, but discover 
that in one or two places you hear two sounds when you click on a slice, then it 
is time to bring out the Lock tool.

1. Find the place where you hear two sounds when auditioning.

2. Make a mental note of the current slider setting.

3. Set the sensitivity slider to a higher value to get a slice between the 
two sounds.

4. Audition to make sure you got what you wanted.

5. Lock the new slice.

6. Drag the sensitivity slider to the original setting.

Clicking on one of the selected slices... ...locks all of them.
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Selecting Slice Markers
Slice markers need to be selected for some operations, like Silence Selected 
(see page 76 and page 68), or when moving and deleting slices (see “Manual 
Slice Handling” in this chapter):

DDDD Selecting is done with the Arrow Tool.
You can have the Pencil Tool selected, but this automatically changes to the 
Arrow tool if you point in the Marker strip.

DDDD You can select one marker by clicking on its triangle symbol.

DDDD If you hold down [Shift], you can click on more markers to select 
them. Clicking again with [Shift] pressed deselects a marker.

Selected and unselected markers.

DDDD You can make up a selection rectangle by pointing between slices 
in the Marker strip, pressing the mouse button and dragging left or 
right. When you release the mouse button, all the slices inside the 
rectangle will get selected.

DDDD You can use the Select All item on the Edit menu to select all mark-
ers.

DDDD If you have a selection of markers, you can invert the selection by 
using “Invert Selection”, also on the Edit menu. 
After this operation, the markers that were previously selected are now de-
selected, and vice versa. This is mainly useful together with Silence Se-
lected, see page 76 and page 68.

Before and after using “Invert Selection”

DDDD To deselect all markers, click between two markers on the ruler.

Manual Slice Handling
It is possible to add new, to move, and to delete slice markers manually.

! Before adding or moving slices manually, make absolutely sure the 
slices found by the analyze algorithm don’t suffice. The program is 
very good at finding slice points, and the points found by the pro-
gram often work better – for example for tempo changes – than the 
ones that you can find manually.

Adding a new slice
1. Identify the area where you need a slice, and zoom in very close on 

it.

2. Select the Pencil Tool.

3. Move the pointer over the waveform display.
A vertical line moves across the waveform. This line indicates where the slice 
will appear when you click. The line snaps to zero crossings in the waveform 
(positions where the amplitude is close to zero), so manually added slices 
won’t introduce any clicks or pops. If the amplitude is zero for a period of 
time, the line will move continuously over this area.

The vertical line snaps to zero crossings.

4. When you have found the correct position, click with the Pencil tool.
The slice appears.

The following rules apply to manually added slices:

• Manually added slices are locked. They will therefore not disappear when 
you lower Sensitivity.

• If you unlock a manually added slice and drag the sensitivity slider down 
lower than halfway (below 50), it will disappear, just as other slices.

Making up a rectangle like this... ...selects these markers.
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Adding a Slice at any position

DDDD If you hold down [Option] (Mac OS) / [Alt] (Windows), the snap to 
zero crossing is disabled and you can add a slice at any position.
We do not recommend that you do this unless you have very good reason, 
since it can introduce clicks and pops in the sound during playback.

Moving a slice marker
You can move a slice marker manually, even if it is locked (muted slice markers 
cannot be moved). 

1. Make sure the Arrow or Pencil Tool is selected.

2. Select the existing slice marker that you wish to move.

DDDD Place it in the proximity where you want to move it to by dragging 
the slice marker.
As you drag, the vertical line of the slice marker is superimposed across the 
waveform. This line indicates where the slice will be placed when you re-
lease the mouse button. 

3. After having placed the slice marker in the general area where you 
would like to move the slice to, zoom in on it very closely and move 
the slice marker to where you want it.
The line snaps to zero crossings in the waveform (positions where the ampli-
tude is close to zero) exactly like when adding slices, so manually moved 
slices won’t introduce any clicks or pops. If the amplitude is zero for a period 
of time, the line will move continuously over this area.

4. When you have found the correct position, release the mouse but-
ton.

! Only one slice marker at a time can be moved.

Moving a slice marker to any position

DDDD If you hold down [Option] (Mac OS) / [Alt] (Windows), the snap to 
zero crossing is disabled and you can move a slice to any position.
We do not recommend that you do this unless you have very good reason, 
since it can introduce clicks and pops in the sound during playback.

When do I add/move Slices manually?
As described above, we suggest you only add or move slices manually when the 
program fails to find one at a position where you need it. In other words, you will 
need to add/move a slice manually when you click on a slice and hear two 
sounds, one after the other, even though the Sensitivity slider is set to 99.

Where do I place the Slice?
Zoom in far enough for the display to clearly show how the cursor jumps be-
tween zero crossings. Try to find the first position before the beginning of the 
sound. This applies both when adding and moving slices.

Deleting Slices
It is possible to permanently delete slice markers. Note that unless you are 
100% certain that you won’t need a slice, especially in case of slices detected 
by the slicing algorithm, it is generally better practice to mute it using the Mute 
Tool. 

DDDD To delete one or more slice markers, select it/them and press 
[Backspace] or [Delete], or select Delete from the Edit menu.

! Deleted slices that were originally ”discovered” by the slicing algo-
rithm can be made to appear again by using Re-Analyze (see page 
56).
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How many Slices do I 
need?
Well, it depends...

• If you plan to edit the loop a lot in your MIDI sequencer, you should try to get 
one slice per sound in the loop, or in some situations (very busy sections for 
example), one slice per eighth note or sixteenth note (to simplify editing in 
the sequencer).

• If you want to create a groove, you should try to get approximately one slice 
per eighth note, sixteenth note or whatever the loop requires.

• If your main reason for slicing the loop is to change the tempo and/or pitch, 
you generally need as many slices as you can get, but never more than one 
per individual sound in the loop. This is to retain the “integrity” of each sound 
when played back from the sequencer.

! Please remember that your ears are always the best judge. Careful 
auditioning is vital for finding a good selection of slices. 

Left and Right Locator — 
Setting the Loop
By dragging
The left and right Locators can be dragged to set the Loop during playback.

DDDD If you have no slices at all (if the Sensitivity slider is all the way to 
the left), the Locators can be positioned freely.

DDDD If there are any slices visible, the Locators snap to the lines.

DDDD If you want to position the Locators freely, even though you have 
slices, hold down [Option] (Mac OS) / [Alt] (Win) while dragging a 
Locator.

By clicking
DDDD To set the Left Locator, hold down [Shift] and click on the ruler.

DDDD To set the Right Locator, instead hold down [Command] (Mac OS) / 
[Control] (Win) and click.

DDDD Normally, the positions snap to the closest slice point, but if you 
also hold down [Option] (Mac OS) / [Alt] (Win) when you click, you 
can set the Locator at any point.

Use the Slices when setting Loop Points!
When trying to find a good loop point, use snap to slices if at all possible. If you 
can’t seem to get a good loop point that way, try raising the Sensitivity slider to 
get more slices and try again.

When – and only when – you can’t find a good loop point in this way, zoom in 
and adjust the Loop positions with [Option] (Mac OS) / [Alt] (Win) pressed.

What are the Locators used for?
The Locators are of course used to define the loop you get during playback. But 
they also have other purposes:

• ReCycle uses the Locator positions when calculating the original tempo of 
the Loop.

• When saving to file etc., only the part between the Locators is actually sent.
• When you create MIDI files, only the section between the Locators is taken 

into consideration, as with the saved audio above.
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Tempo, Time Signature, 
Bars and Beats
Many of the operations in ReCycle require you to specify how long the loop be-
tween the Locators actually is, meter-wise. This information is then used to cal-
culate the tempo of the loop.

Time Signature
The Sign pop-up menu allows you to choose between a few of the more com-
mon Time Signatures. If none of them fit your purpose, you can still “assemble” a 
correct Time Signature using the Bars and Beats settings, see below.

Bars and Beats
The Bars field and Beats pop-up are used to specify the length of the loop. Let’s 
explain this by example:

As stated above, you can use Bars and Beats to “create” some unusual Time 
Signatures:

Original Tempo

When the Left and Right Locators are set, and the correct Time Signature and 
loop Length (Bars and Beats) have been specified, this area will show the
calculated original tempo of the loop. 

| Actual Loop Length | Set “Bars” to: | Set “Beats” to:

One bar 1 0

Two bars 2 0

Half a bar in 4/4 0 2

One and a half bar in 6/8 1 3

| Actual Loop Length | Time Signature |  Bars | Beats

Two bars in 7/4 4/4 3 2

One bar in 9/8 6/8 1 3
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About the Effects
ReCycle features three effect processors, Envelope, Equalizer, and Transient 
Shaper, that can be used to further manipulate audio loops. 

DDDD All effects are applied globally, i.e. they will affect all slices equally 
in a loop.

DDDD To be able to apply the effects, Preview mode must be activated.
To activate Preview mode for a file you must first set up the left and right lo-
cators, specify the length and time signature of the loop and create a suffi-
cient number of slices (see the previous chapter). You could also load REX2 
(ReCycle’s native file format) files for further processing of course, in which 
case these settings have already been made and you can apply effects in 
Preview mode directly.

DDDD The principle “what you hear is what you get” applies when you ap-
ply effects, like with all the other Preview mode functions. 

Open the Effect Panels

The three Effect buttons (from left to right); Envelope, Transient Shaper and 
Equalizer.

The three Effects each have their own panel, containing the parameters. By 
clicking on one of the effect buttons located to the left of the transport controls 
on the Toolbar, the corresponding panel is shown below the toolbar. You can 
also open the effect panels from the View menu. 

DDDD The top to bottom order of the Effect panels also reflects the inter-
nal signal path of the effects. 
If all are activated, Envelope is always the first effect in the signal path, the 
Transient Shaper is the second, and Equalizer is the last.

Activating Effects
Effects can be active regardless of whether the panel is visible or not. There are 
two ways you can activate effects:

DDDD By clicking on the Effect On/Off button on an open panel.
When an effect is on (activated), the On/Off button is lit, and a blue light is 
shown in the effect button for the corresponding effect.

Effect On/Off button and the corresponding lit effect button (in this case the Envelope 
button). 

DDDD By holding down [Option] (Mac) / [Alt] (Win) and clicking on an ef-
fect button you can toggle the effect on and off.

About the Presets
For each Effect there are a number of preset settings available. 

DDDD To select a Preset, click on the Preset button beside the Effect On/
Off button.
A pop-up menu appears with the available Presets listed.

The Effect Presets button.

! It is not possible to store user presets.

About the Parameter Controls
For all effect parameter controls, the following applies:

DDDD [Shift]-clicking a parameter increases the resolution of the adjust-
able range.
Use this for a finer tuning range.

DDDD [Ctrl]-clicking (Win) / [Command]-clicking (Mac) a parameter resets 
the parameter to the default value.
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Effect Parameters
Envelope

To open the Envelope processor, click on the Envelope button, or select Enve-
lope from the View menu.

The Envelope Attack and Decay parameters govern how the volume of a slice 
should change over time, from the time it is triggered (the slice note starts) until 
the slice note ends. This can be used to make a loop more distinct (by having a 
snappy attack and a short decay time) or more spaced-out (by raising the attack 
time). Short attacks can also be used to mask out clicks that may occur with cer-
tain types of loops, when played back with a different tempo than the original.

The Envelope panel also features a third parameter; “Stretch”, which is de-
scribed separately below.

DDDD The Attack parameter determines the attack length (in millisec-
onds) for each slice.
The higher the setting, the slower the attack. Parameter range is 0 - 0.5 s.

DDDD The Decay parameter controls the length of the end portion (tail) of 
each slice.
The more the knob is turned anti-clockwise, the shorter the decay. Range is 
27ms - Infinite (=full decay).

Stretch
This feature is used when you know you might want to lower the tempo of the 
loop in your MIDI sequencer.

How Stretch works

When you slice up a loop and play it back from your sequencer, each sample will 
play in succession. At the original tempo, one slice will end exactly where an-
other starts.

As you understand, when you then lower the tempo, there will be small gaps be-
tween the slices, which disrupts the flow of the audio.

Stretch is used to add an extra tail of audio to each slice, to lengthen it. This is 
derived from the natural decay of the sound. This extra tail of sound then fills out 
the gap between the slices when the tempo is lowered.

! Please note that the attack of the sound is not affected in any way. 

The Amount of Stretch

The Stretch knob is used to set the amount of stretch as a percentage value. 

The percentage values tell you how much longer the entire sample will be after 
stretching. If you select the largest value (100%), for example, the slice will be-
come twice its original length when exported.

DDDD To decide how much stretch you need, lower the Preview tempo by 
the same amount as you intend to use, and adjust the Stretch pa-
rameter as necessary. 
If there is a discernible gap of silence between slices you should raise the 
Stretch setting.

! Note that Stretch is not Time Stretch! The Stretch feature doesn't 
lengthen the whole slice, it only adds a portion of sound to the end 
of it. 

Stretch and the old REX Formats

You should be aware of the fact that REX (as opposed to REX2) files can con-
tain certain settings that are irreversible. For example, if stretch was applied 
when the file was saved, the stretching is part of the actual REX file and cannot 
be removed. It is possible, however, to apply more stretch, which may or may not 
be what you want.

DDDD For REX files it is therefore advisable to try lowering the tempo in 
Preview mode first, to see if you actually need to apply Stretch.
REX2 files however, only contain the actual audio and the slices, the rest (ef-
fects, stretch setting etc.) is added when the file is loaded and can be 
changed at any time.
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Transient Shaper

Transient Shaper parameters...

...and the Gain meter.

The Transient Shaper is a type of attack/release envelope control, which pro-
duces a result that could be likened to compression. Compressors level out the 
audio, by making loud sounds softer and vice versa. The result is that the levels 
become more even and individual sounds can get more power and “punch”. 
• “Normal” compressors are activated by peaks and volume changes in the 

actual audio. The Transient Shaper is instead activated by the individual 
slices in the loop. 

Regardless of method, if you have ever used a compressor, you will find that the 
Transient Shaper will affect the sound in a similar way. It is, however, important 
to be aware of this difference, as the Transient Shaper won’t work as intended 
unless the file contains slices!
To compensate for the volume loss that can be caused by this effect, the Tran-
sient Shaper has automatic gain compensation, that raises the overall level by a 
suitable amount. The parameters are as follows:

Equalizer

The main Equalizer parameters.

Lo Cut and Hi Cut parameters.

The Equalizer allows you to cut or boost selected frequencies to shape the over-
all sound quality. To open the Equalizer panel, click on the Equalizer button or 
select it on the View menu. The parameters are as follows:

| Parameter | Description

Threshold This is the threshold level above which the effect sets in. After 
the initial slice attack, signals with levels above the threshold 
will be affected, signals below it will not. In practice, this means 
that the lower the Threshold setting, the more the signal will be 
affected by the Transient Shaper. The range is -6 to -40 dB.

Amount This lets you specify the amount of gain reduction applied to 
the signals above the set threshold. The range is 0 to 99.

Attack This governs how quickly the envelope will apply its effect 
when signals rise above the set threshold. If you raise this 
value, the response will be slower, allowing more of the signal 
to pass through unaffected. Typically, this is used for preserv-
ing the attacks of the sounds. The range is 0 to 91 ms.

Release When the signal level drops below the set threshold, this de-
termines how long it takes before the Transient Shaper lets the 
sound through unaffected. Set this to short values for intense, 
“pumping” compressor effects, or to longer values for a 
smoother change of the dynamics. The range is 13 ms to 1.4 s.

Gain meter This shows the amount of gain reduction or increase (in dB), 
caused by the combined compression and gain compensation.

| Parameter | Description

Lo Cut A highpass filter allowing you to set the lower limit 
of the overall frequency range. You can progres-
sively cut frequencies from 15 Hz up to 12 kHz.

Low Frequency The center frequency for the low-end equalization. 
Around this frequency, the sound will be boosted 
or cut according to the Low Gain setting. The avail-
able frequency range is 20 Hz to 3 kHz. 

Low Gain Governs the amount of boost or cut around the set 
frequency. The range is ± 18dB.

Low Q Determines the width of the frequency band 
around the center frequency to be affected. The 
narrower frequency band, the more drastic effect 
of the boost or cut. Range is 0.5 to 10.

High Frequency The center frequency for the high-end equalization. 
Around this frequency, the sound will be boosted 
or cut according to the High Gain setting. The 
available frequency range is 1.5 kHz to 16 kHz. 

High Gain Governs the amount of boost or cut around the set 
frequency. The range is ± 18dB.

High Q Determines the width of the frequency band 
around the center frequency to be affected. The 
higher the Q setting is, the narrower the frequency 
band will be, and this will cause a more drastic ef-
fect of the boost or cut. Range is 0.5 to 10.

Hi Cut A lowpass filter allowing you to set the upper limit 
of the overall frequency range. You can progres-
sively cut frequencies from 20 kHz down to 100 
Hz.
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The Process Menu

 

In addition to the three Effect processors, there are several other “offline” (non-
realtime) audio processing functions available on the Process menu. You do not 
have to use Preview mode to apply offline processing. The Process menu items 
are as follows:

• Normalize
• Convert to Mono
• Convert Sample Format
• Crop Loop
• Remove DC
• Re-Analyze

 

Normalize

 

Normalize will change the gain to ensure maximum level.

  

DDDD

 

When Normalize is selected on the Process menu, a dialog box ap-
pears asking if you want to Normalize the whole file or each slice.

 

Normally, you will select “Whole File”. If you select “Each Slice”, and the se-
lected file is a rhythmic loop, the normalizing will disrupt the inherent dynam-
ics of the loop, since the gain of each slice will be changed to more or less 
equal level.

  

DDDD

 

Normalizing each slice can be useful when you use ReCycle to pro-
cess individual sounds that don’t belong to a loop.

 

!

 

Normalize can’t do miracles. If your recording contains unwanted 
noise, normalizing will increase the noise level together with the 

 

other audio material.

 

Convert to Mono

 

This Process menu item will convert stereo files to mono. It is only selectable for 
stereo files. 

  

DDDD

 

When this item is selected, a dialog appears asking which chan-
nel(s) you wish to use as the basis for the converted file.

 

The options are Left, Right or a mix of both Left and Right channels.

 

Convert Sample Format

 

This item allows you to convert the sample rate and bit depth of a file. Lowering 
the sample rate will make files smaller, but it will also lower the fidelity of the re-
cording (less high frequency material will be present). 

On the other hand, increasing the sample rate will not raise the fidelity of the 
sample in any way. It is therefore not recommended to convert from a low rate to 
a higher one, unless it is required by the application. 

The same applies to bit depth; converting from 24 to 16 bits will reduce the size 
of the file (at the expense of slightly lower fidelity) and converting a sample’s bit 
rate from 16 to 24 bits will not increase the fidelity of the original sample.

Selecting this menu item brings up a dialog box. You select the format you wish 
to convert to using the respective pop-up menus.
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Crop Loop
DDDD Crop Loop allows you to trim files, by removing all audio data out-

side the left and right locators.
If you have set up a perfect loop with the locators, and the file contains audio 
outside this locator range you can use Crop Loop to remove this superfluous 
data.

Remove DC
This function will remove any DC offset in the audio. DC offset is when there is 
too large a DC (direct current) component in the signal, sometimes visible as the 
signal not being visually centered around the “zero level axis”. DC offset can in-
troduce clicks if the slices are later moved around in a sequencer, and it also af-
fects zero crossing detection (see page 47) and certain processing functions 
such as Re-Analyze and Normalize.

Re-Analyze
Re-Analyze re-runs the slice-detection algorithm on the waveform data. You may 
have deleted slices that were detected when the file was first sliced. This com-
mand will ”re-discover” those slices. 

DDDD Re-Analyze will add all slices to positions in the file not already
occupied by other slices. 
Note that the added slices may not be visible, as this depends on the Sensi-
tivity setting!

Additional Processing 
Items
There are a number of additional real-time processing items available on the 
Toolbar (Preview mode must be activated):

Processing Gain

This function allows you to change the gain (volume) of the loop. The applied 
gain change will be present when the loop is saved or exported.

The main use of this function is to compensate for possible clipping or level 
changes introduced by other processing items, like equalization for example.

DDDD You can boost the gain by up to 18 dB, or lower it down to silence 
(-80 dB).
You should avoid boosting the signal to the extent that the Level Meter clip 
indicators light up often. If they momentarily light up once, you should listen 
carefully to see if it sounds ok (a slight amount of clipping on percussive ma-
terial is not necessarily even noticeable). The final judge is your ears!

Gate Sensitivity

Gate Sensitivity could be described as a type of noise gate. It is triggered 
(opened) by every active slice start, and closes for any material (in each slice) 
that falls below a set threshold. When you set the Gate Sensitivity so that the 
end part of the slice(s) fall below the threshold, the gated part of the waveform 
will be greyed out. The “gated out” material is not exported.

This function has three primary uses:

DDDD It can be used to remove part of a file that contains silence, for ex-
ample in conjunction with Silence Selected (see page 76).
By removing “silent data”, the size of the exported data is reduced.

DDDD It can be used if you have a file with several individual sounds con-
taining “air” in between the sounds, and want to save each one as a 
separate file.
This also keeps the size of the exported data down.

DDDD It can be used for special effects, e.g. abruptly chopping off a reverb 
tail.

Preview Pitch

You can change the pitch of a loop up or down two octaves (+/- 24 semitones). 
Hold down [Command] (Mac) / [Ctrl] (Win) and click the Pitch knob to reset the 
pitch back to original. Hold down [Shift] for adjusting values in finer increments.

Preview Tempo

You can change the tempo of the loop. Tempo values between 20 to 450 BPM 
can be set using the Tempo knob or by typing directly in the Tempo box and 
pressing [Enter]. 

Hold down [Command] (Mac) / [Ctrl] (Win) and click the Tempo knob to reset 
the tempo back to the original. Hold down [Shift] for adjusting values in finer in-
crements.
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Saving ReCycle 
Documents
If you have opened an audio file and worked on the slices and other settings, you 
can save it as a ReCycle (REX2) document. 

DDDD Saving is done using the regular “Save” and “Save As” commands.

DDDD ReCycle files can be opened just like regular audio files (see page 
26). 
One difference is that no analysis needs to be performed, since the analysis 
data is already included in the file.

DDDD ReCycle files have the extension “.rx2”.

DDDD The ReCycle document will include all settings made in Preview 
mode as well as the actual audio data. 

These include:

• All the slice points and their status (locked, muted etc.).
• All real-time processing features, like tempo, pitch settings, Stretch amount 

etc.
• Any applied offline processing like Normalize etc.

Export Options
On the Process menu, you will find two Export settings (or “options”); ”Export as 
One Sample” and “Silence Selected”. These options can also be toggled on or 
off using the two Export Option buttons on the Toolbar:

DDDD Export as One Sample has no effect on playback in ReCycle. Si-
lence Selected, however, can be auditioned in Preview mode.

DDDD Each document has its own settings. 
If you are working with a lot of windows, be sure to check that the settings 
are correct before you Export. The settings are also saved to disk with the 
file when you Save.

Export as One Sample

Deactivated

When Export As One Sample is turned off, the audio gets sliced into individual 
samples when exported, and the MIDI files created will contain one note for 
each of those slices.

! This is the preferred mode if you want to use your MIDI sequencer 
to edit the loop, change its tempo or use the MIDI file as a groove.

Activated

When Export As One Sample is turned on, the program will save/export the part 
that stretches from the Left Locator to the Right as one sample. Also, in this 
mode, the MIDI File will only consist of one event, with the length set using the 
Bars and Beats settings.

When should Export as one Sample be Activated?

One obvious application of exporting as one sample (as opposed to separate 
slices) is when you simply want to change the properties (like pitch and/or 
tempo) of an audio file without otherwise changing it. Say you have an audio file 
(Wave, Aiff etc.) that you wish to use in a song. The problem is that the tempo 
and/or the pitch of the file is wrong for the song, and you wish to fix this. The so-

Export as One Sample Silence Selected
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lution is to open the file in ReCycle, then slice it up and set the length of the loop 
using the normal techniques. Enter Preview mode, set the new tempo and/or 
pitch, and lastly export the file in it’s original format but with a new tempo and/or 
pitch etc. A step by step example of exporting to file can be found on page 23.

Export as One Sample can also be used in conjunction with Silence Selected to 
separate sounds from a loop (see below and on page 68).

Silence Selected
When this function is activated, the slices that have selected markers will be si-
lenced when saved or exported. Preview mode has to be activated for Silence 
Selected to be available.

When Silence Selected is turned on, the slices which have selected markers...

...will be replaced by silence.

This feature is probably best used when Export as One Sample is turned on, to 
silence individual sounds in a longer sample. An application of this is found on 
page 68. It can also be used to simply skip unwanted sounds, when slicing. 

But, Silence Selected works even if Export as One Sample is turned off. In this 
case, the selected slices will simply be skipped when creating MIDI Files. You 
can use the Gate Sensitivity parameter (see page 56) in combination with this 
feature to remove the silenced portions of the loop.

Exporting Files
The Export Sound dialog is opened by selecting “Export...” on the File menu, or 
by clicking the Export Sound button.

The Export Sound is similar to the normal Save dialog, but contains a few extra 
items. The Export dialog is used if you want to save your files in other formats for 
which the program saves audio files on your computer’s hard disk. 

It can also be used to change the inherent properties of a sound file. You could 
for example load a Wave file, change the file’s tempo and export it as a new 
Wave file.
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File Formats
The following Export file formats are supported:

Export Settings

Before exporting a file in one of the supported formats, the Export Settings dia-
log is shown. The following items cam be set:

DDDD A Sample Rate pop-up allows you to change the sample rate when 
Exporting.
The pre-selected sample rate shown in the dialog is the original sample rate 
of the audio file.

DDDD A Bit Depth pop-up allows you to change the bit depth when Export-
ing.
The pre-selected bit depth shown in the dialog is the original bit depth of the 
audio file.

DDDD An “Export MIDI File with Same Name” tickbox.
When checked, a MIDI file with the specified name, plus the extension 
”.MID” will be generated together with the exported file. 

! The above options are not available for Standard MIDI files or Mix-
man TRK files. 

Exporting MIDI Files
There are two ways to create MIDI Files with ReCycle:

DDDD By selecting Export from the File menu and then selecting “Stan-
dard MIDI File” as the File Format in the dialog.
This is used if you wish to create a groove template.

DDDD By selecting Export from the File menu and then ticking the “Export 
MIDI File with Same Name” option in the Export Settings dialog.
If the file has been sliced for tempo changes, you will need this MIDI file to 
play the slices from a sequencer. This only applies to the Soundfont 2, Akai 
S5000/6000 or Sample Cell formats.

| Name | Ext. | Comment

Standard MIDI File MID Allows you to export a MIDI file (see page 
60 for details).

Wave WAV The standard Microsoft file format for audio. 
Exports one or several files, with one slice in 
each file, depending on the “Export as One 
Sample” setting on the Process menu.

Audio IFF
(AIFF)

AIF Audio Interchange File Format; Apple’s 
standard audio file format. Exports one or 
several files, with one slice in each file, de-
pending on the “Export as One Sample” 
setting on the Process menu.

Sound Designer II 
(Mac OS only)

SD2 The current Digidesign file format. Exports 
one file only.

Mixman Track File TRK Mixman TRK (for “Track”) files are the build-
ing blocks in the Mixman Studio and Mix-
man Studio Pro applications. To facilitate 
tempo-matching, the Mixman TRK files con-
tain “slices” internally (somewhat like ReCy-
cle files). A single mono file is created 
(Mixman files are always mono).

SoundFont 2 
Banks

SF2 SoundFont is a file format for storing wavet-
able synthesized sounds. Effectively, this 
turns an ordinary sound card into a sampler. 
Creates a single file when exported. For 
more information see page 64 in this chap-
ter.

Sample Cell Instru-
ment File

INS Digidesign’s SampleCell is a PCI based 
sampler card/software editor for both the 
Mac and Windows platforms. Creates AIFF 
(Mac OS) or Wave files (Windows). See 
page 61 in this chapter for more info.

Akai S5000/S6000 
Program Files

AKP Exports a program file together with one or 
several Wave files, with one slice in each 
file, depending on the “Export as One Sam-
ple” setting on the Process menu. AKP files 
are program files for the Akai S5000/
S6000 series of samplers - for more infor-
mation see page 62 in this chapter.
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In either case you are prompted with a regular File dialog where you can specify 
a name and location for the file.

ReCycle always creates MIDI Files of type 1. However, they only contain one 
Track plus a Tempo Track.

“Export As One Sample” and MIDI Files

• If Export as One Sample is turned off, the MIDI File will contain a number of 
short events, each triggering a slice, to recreate the loop. This is the mode to 
use if you want to create a “groove map”.

• If Export as One Sample is turned on, there will only be one long event which 
triggers the entire sample.

“Silence Selected” and MIDI Files

Silence Selected only affects the MIDI File if Export as One Sample is turned off, 
as described on page 76. 

About Sample Cell
ReCycle supports all models of SampleCell both on the Macintosh and Win-
dows platforms.

ReCycle creates SampleCell Instrument and Sample files which it saves to your 
computer’s hard disk.

Documents Created
ReCycle saves the SampleCell audio as Multisample Instrument files together 
with a number of sample files, all in the same folder.

DDDD SampleCell for the Macintosh saves files in the Aiff format. 

DDDD SampleCell for Windows saves files in the Wave (WAV) format.

SampleCell I and II (Macintosh)
Files created with ReCycle 2.1 can be used with either of the two types 
of SampleCell cards for Macintosh, I and II. But, the Instruments ReCycle  
creates require the SampleCell II editor to be loaded.

! SampleCell I is limited to loading 20 samples into one Instrument. 
Therefore, you can not use loops with more than 20 slices with a 
SampleCell I card!

Preferences (Macintosh)
In the SampleCell Macintosh Preferences dialog you will find a setting called 
“Automatically remap instruments in a bank after adding an instrument”.

! This preference must be turned off, or the first slice in a loop might 
have its tuning changed!

Loop Settings
ReCycle will add Loop markers at the beginning and end of the loop if Export As 
One Sample is turned on. To make a sample actually loop, the only thing you 
have to do is to turn on looping in the SampleCell editor. If you know you want 
looping to start with, set up a Template Instrument with looping turned on.

SampleCell Tuning Parameters
The SampleCell editor allows you to perform some very powerful editing to the 
entire Instrument and to the samples within it. However, there is one parameter 
which doesn’t really behave as you might expect.
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The tuning parameter in the Miscellaneous group of parameters for an Instru-
ment doesn’t really tune a sample, instead it shifts the MIDI input up or down 
along the “keyboard”. This means that instead of changing the pitch of all the 
slices in a loop, it will make the MIDI file play the wrong slices in the loop.

If you want to tune the slices in a loop you have two options:

• Either go into the key map and set the tuning individually for each slice in the 
loop, or...

• Map a modulation parameter to pitch and use that to change the pitch 
equally for all sounds in the Instrument.

Sample Rates
SampleCell supports any sample rate, so no conversion is ever required with 
this instrument.

Stereo Support
SampleCell supports stereo files.

About Akai S5000/6000
When you select this format in the Export dialog, you export a program file (AKP) 
together with the separate audio files. These files can be transferred to your 
sampler using one of the following two methods:

DDDD By using the application “ak.Sys”.
This is described below.

DDDD By transferring the files via a removable media.
This is described later in the chapter.

About ak.Sys
This is an application developed by Akai that enables direct file transfers be-
tween your S5000/S6000 and your computer via USB. This is the most conve-
nient method of transferring files between the sampler and your computer (i.e. 
ReCycle). 

DDDD The ak.Sys software features a “browser” that facilitates direct ac-
cess to your S5000/S6000 sampler (and any drives connected to the 
sampler). 

DDDD Items can simply be dragged from disks shown in the browser into 
the sampler’s memory for quick loading. 
Also, a sample’s ‘properties’ may be changed directly in the browser (i.e. 
loop mode, pitch and tuning).

DDDD ak.Sys is available for both Mac OS and Windows.

DDDD The program requires that a USB interface card is installed in your 
S5000/S5000 and that your computer also has a USB interface.
A USB card for your S5000/S6000 is included with ak.Sys, and USB is 
standard on recent PC and Macintosh models (you can install USB cards on 
most older models).
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Using ReCycle with ak.Sys
ReCycle can export S5000/S6000 Program files (AKP) together with the audio 
files which can be loaded in ak.Sys. 

Proceed as follows:

1. Open the Export Sound dialog on the File menu.

2. Select “S6000 Program File” from the Type pop-up menu.
The S5000 uses the same format.

3. Select a destination for the exported files.
If the loop to be exported has been sliced for tempo changes, it is a good 
idea to export to a folder on the disk, for easier handling of the separate 
wave files that will be created.

4. Click Save.
The Export Settings dialog opens.

DDDD Make sure “Export MIDI file with Same Name” is ticked if the ex-
ported file has been sliced for tempo changes.

5. Click “Export”.

Three types of files will be exported (given you have chosen to export a MIDI file 
in step 5):

DDDD A Program file with the extension *.akp.

DDDD Audio files in the Wave format, one for each slice.
If “Export as One Sample” is ticked on the Process menu, only a single wave 
file will be exported. 

DDDD A MIDI file.
This file should be used in your sequencer to play the slices in the loop.

From here, please refer to the ak.Sys documentation for specifics about loading 
the files into the program.

Transferring files without using ak.Sys
Without the ak.Sys application, it is not possible to transfer files directly to the 
sampler. You use the same basic method in ReCycle, i.e. using the Export 
Sound dialog, but the resulting files have to be transferred to disk or some other 
media, and then be “manually” moved to a compatible media drive connected to 
the sampler. 

DDDD The file format used by S5000/S6000 is MS-DOS, and the native au-
dio file format is Wave.
This enables both Windows and Mac OS users to format disks that can be 
read by these samplers.

! Macintosh computers can read and format MS-DOS disks, and also 
mount PC SCSI disks. 

DDDD The recommended method is to use a removable disk media, for ex-
ample Zip, Jaz or MO.
You could of course use ordinary floppy disks as well, or an external hard 
drive. In the former case, you wouldn’t need an external drive at all (given that 
your computer has a built in floppy drive).

The setup should preferably comprise two removable media drives of the same 
type. One is connected (or built in) to your computer, the other is SCSI con-
nected to the sampler. To transfer files is then simply a matter of moving the disk 
from one drive to the other. If you only have access to one external drive (and you 
do not have a built in drive of the same type), you will have to swap the drive be-
tween the two devices.

! Never “hot swap” SCSI devices! Make sure all devices are switched 
off before disconnecting or connecting SCSI cables.

! SCSI connecting a S5000/6000 sampler to a Mac or PC to share a 
disk drive is definitely not recommended! Please refer to Appendix 
D in the Akai S5000/S6000 Operator’s Manual for more details.

The following steps describe how you can transfer files between ReCycle and 
the S5000 or S6000 sampler without using ak.Sys.

1. If you are planning to use an external SCSI drive, make sure your 
drive is properly connected and can be “found” by your computer 

2. Format whatever media you intend to use to transfer the files.
You must use the MS-DOS file format!

3. Open the Export Sound dialog on the File menu.

4. Select “S6000 Program File” from the Type pop-up menu.
The S5000 uses the same format.

5. Select the destination for the exported files.
If the loop to be exported has been sliced for tempo changes, it is a good 
idea to export to a folder on the disk, for easier handling of the separate 
wave files that will be created.

6. Click Save.
The Export Settings dialog opens.

7. Make sure “Export MIDI file with Same Name” is ticked if the ex-
ported file has been sliced for tempo changes.

8. Click “Export”.
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Three types of files will be exported (given you have chosen to export a MIDI file 
in step 7):

DDDD A Program file with the extension *.akp.

DDDD Audio files in the Wave format, one for each slice.
If “Export as One Sample” is ticked on the Process menu, a single wave file 
will be exported. 

DDDD A MIDI file.
This file should be used in your sequencer to play the slices in the loop.

Loading the Exported Files
Once you have saved the files to disk, and made the necessary connections you 
can load the Program file and the associated samples in the normal way. 

Refer to Appendix C in the Akai S5000/S6000 Operator’s Manual for details

Requirements 
You need the following:

DDDD The required operating system for your sampler:
New operating systems can be downloaded from Akai’s Web site.

DDDD For ak.Sys, you also need to have a USB card installed in your sam-
pler, and a USB cable connected between your sampler and your 
computer.

DDDD Without ak.Sys, you need some means of transferring files between 
your computer and the sampler (as outlined above).

About SoundFonts
SoundFont is a file format for storing wavetable synthesized sounds. The format 
is developed by E-mu Systems and Creative Technologies. It allows users to 
create and edit multi-sampled sounds, and play them back in wavetable synthe-
sizers, typically on audio cards (e.g. Creative Technologies AWE-32, AWE-64 
and Soundblaster Live!, Terratec EWS-64 and E-mu APS).

In broad terms, a SoundFont Bank consists of Presets, which contain references 
to one or several Instruments. Each Instrument in turn contain references to a 
number of Samples, complete with key and velocity range information. There are 
also several levels of articulation data (filtering, modulation settings, etc.). These 
are not affected when ReCycle generates SoundFont files, but they make it pos-
sible to change the sound in a SoundFont editor later on.

Requirements
There are no actual requirements for ReCycle to be able to export SoundFont 
files, but to make use of the files, you need the following:

DDDD A SoundFont compatible audio card with RAM installed.

DDDD An application that can load the exported SoundFont file into the 
RAM on the audio card.
If you are using a Creative audio card under Windows, you can load Sound-
Font banks using the AWE Control Panel application.

DDDD An application that plays MIDI files.
This would typically be a software sequencer, like Cubase VST.

Using ReCycle with SoundFonts
When you have set up and sliced a loop in ReCycle (see the printed documen-
tation), you export it as a SoundFont file using the following procedure:

1. Select “Export” on the File menu.
The Export dialog appears, allowing you to specify a name and location for 
the resulting file.

2. Select “SoundFont” on the Type pop-up.

3. Click “Save” when you have named and specified a location for the 
file.
The Export Settings dialog opens.

4. With the “Export MIDI file with Same Name” option ticked, click Ex-
port.

Now, a SoundFont Bank file is created, together with a MIDI file. The SF2 file 
contains a single Melodic Preset, which contains a single Instrument. The Instru-
ment contains all the slices (as separate samples), laid out chromatically with 
one sample per key, from key number 36 (C1) and upwards.

5. Use a SoundFont editor or bank manager program to load the 
SoundFont file into the RAM of your audio card.
See the documentation of the program for details.

6. Open the generated MIDI file in a sequencer, and set it to play back 
to the MIDI synthesizer on the card, using your generated Sound-
Font Bank as sound source.
You will hear the original loop played back, but you will be able to change 
the tempo, remove or reorder individual slices, etc. You could also use the 
SoundFont editor software to manipulate individual slices in various ways.
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Which Samples will work?

 

All. Although ReCycle does a very intelligent analysis of the sample to find the in-
dividual “hits” or “sounds” in it, the sample has to meet some basic criteria to en-
able the automatic algorithm to find all the individual sounds:

• Each sound in the sample must have 

 

some

 

 kind of perceivable attack. You 
will for example run into problems with legato playing on a flute.

• The sample must be adequately recorded. Weak sounds recorded at very 
low volumes might not get all the slices they should.

• The program might have problems with sounds drowned in smearing ef-
fects, like extremely thick chorus or short repeating delays.

Please remember that you always have the possibility to add slices “manually”.

 

Using Normalize and Re-Analyze to increase 
“readability”

 

If you have a loop that was very poorly recorded, you might be able to get a bet-
ter recognition by normalizing it and then applying Re-Analyze (see page 56).

 

!

 

You should first check if the file contains DC offset (see page 56) 
and if so, remove it. The presence of DC offset can negatively affect 

 

both the Normalize function and Re-Analyze.

1. Select “Normalize” from the Process menu.

 

A dialog appears asking if you would like to process the whole file or each 
slice (see page 55).

 

2. Select “Whole File”

 

The file is now normalized. 

 

3. Select Re-Analyze from the Process menu.

4. Raise Sensitivity to check if the recognition got better.

 

The Simple Trim

 

The most basic thing you can do with ReCycle is to set a good loop point for a 
sample and then export it as a file, without any slicing or processing.

 

1. Open or Receive the sample.

2. Raise the Sensitivity until a large number of slices appear.

3. Activate playback and move the loop points until you find a good 
loop.

4. Make sure the loops starts on a downbeat (sometimes you might 
decide to let the loop start somewhere else but we just want to 
make sure this doesn’t happen by accident).

5. Set the Time Signature and length (Bars/Beats) to whatever the 
length of the loop.

 

The Tempo gets calculated.

 

6. Make sure “Export as One Sample” is selected (ticked) on the Pro-
cess menu, and that Stretch is set to 0%!

7. Export the file in the format of your choice.
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Slicing for Tempo 
Changes
1. Open the sample in ReCycle.

2. Raise the Sensitivity Slider until a lot of slices appear.

3. Activate playback and move the loop points until you find a good 
loop.

4. Work on the slices with the Mute and Lock tools until you have one 
slice per sound in the loop.
It is important that no slice plays two consecutive sounds, so audition them 
one at a time to check. 

5. Set the Time Signature and length (Bars/Beats) to whatever the 
length of the loop.
The Tempo is calculated. 

6. Click the Preview Toggle button to enter Preview mode.

DDDD The Stretch factor is by default set to 40%.
Use the Preview Tempo knob to check how the loop plays back at different 
tempi and change the Stretch setting according to how much you want to 
lower the tempo.

From here you have two ways to go, depending on what you would like to do 
with the loop:

DDDD You could export the file in another format using the Export dialog.
See next page.

DDDD You could save the file as a REX2 file.
See page 58.

In case of it being exported as a SoundFont Bank file, you proceed as follows:

7. Use a SoundFont editor or bank manager program to load the 
SoundFont file into the RAM of your audio card.
See the documentation of the program for details.

8. Open the generated MIDI file in a sequencer, and set it to play back 
to the MIDI synthesizer on the card, using your generated Sound-
Font Bank as sound source.
Try varying the tempo.

Slicing for Tempo 
Changes - Exporting to 
Audio File
In the previous example, the result was a number of slices - in a sampler keymap 
or contained in a REX2 file. However, if you plan to use the file in an application 
that only reads regular Wave and AIFF files, you want to export your loop as one 
file, in any specific tempo or pitch that you decide. Proceed as follows:

1. Follow steps 1 to 6 in the previous example.

2. Enter the tempo, and/or the pitch that you wish the file to play back 
in (you can also add additional processing if you like).
If you have lowered the tempo by a large amount, check (listen for “gaps” 
between the slices) if you have to raise the stretch amount.

3. Activate “Export as One Sample” on the Process menu.

DDDD Export the file in the format of your choice using the Export File di-
alog - see page 59.
The result is a single file that plays in the tempo and pitch specified by the 
Preview settings.
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Slicing for Editing
If your main goal is to edit the loop, rather than changing its tempo, you may take 
a slightly different approach compared with slicing for tempo changes:

1. Set things up as in the previous example.
If you activate “Show Grid” on the View menu, finding exact positions be-
comes much easier.

2. Work on the slices with the Mute and Lock tools until you have ap-
proximately one slice per eighth note, sixteenth note or whatever 
you need, depending on how detailed an edit you want to do.
If a slice plays more than one sound, please remember that you won’t be 
able to edit these two sounds independently. There are occasions when this 
will be perfectly OK though, for example when you just want to shift the or-
der of the beats around in the loop.

3. Proceed as from point 5 in the  “Slicing for Tempo Changes” section.

4. In the MIDI Sequencer, open the MIDI File for editing. 
When you move slices around, make sure they keep their relative position to 
the beats, eighth notes etc., to maintain the integrity of the timing in the 
groove.

Using Silence Selected 
Even if you don’t want to cut up a loop in slices, you can still use ReCycle to 
send different sounds in the loop to different channels in the application that will 
reproduce the file outputs on your sampler to apply processing to only one drum 
in a loop for example. The example below assumes you only want to pick out one 
sound, but the same technique can of course be applied to separate as many 
sounds as you need.

1. Open the sample.

2. Raise the Sensitivity until a lot of slices appear.

3. Activate playback and move the loop points until you find a good 
loop.

4. Set the Time Signature and length (Bars/Beats) to whatever the 
length of the loop.
The Tempo gets calculated.

5. Click the Preview toggle button to enter Preview mode.

6. Make sure “Silence Selected” and “Export as One Sample” are ac-
tivated (ticked) on the Process menu.

7. Work on the slices until they play one sound each when you click on 
them.

8. Select all slice markers which play the same sound, for example the 
snare drum.
Play it back to check that all snares are silent.

9. Now either export the file in the format of your choice using the Ex-
port dialog or save the file.
The MIDI File you get will contain one event which plays the entire loop at 
the calculated tempo.

10. With the selection still set up as before, select “Invert Selection” 
from the Edit menu.
Now all sounds that are not snares are selected.

11. Save or Export the file again, but under another name.

12. Set up the sequencer so that the two samples are played back at 
the same time, but over different channels. 
They will together recreate the loop as it was, but the snare will be separated 
to its own output, which means that you have independent control over its 
volume, that you can process it separately etc.
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Extracting a Groove 
If you think about it, you will realize that all ReCycle MIDI Files are actually timing 
maps of how the drums were played in the loop. Many sequencer programs 
have the ability to load MIDI Files and apply their timing to the sequenced parts. 
The terminology used is “Match Quantize” or “Groove”. 

If you use a ReCycle MIDI File as a “groove template”, you can make your se-
quenced parts play back with the timing of the drum loop. For this, you could of 
course use the MIDI File you get when exporting. But, you can also create a tim-
ing file only, by exporting the file as a Standard MIDI File. Proceed as follows:

1. Open the sample.

2. Raise the Sensitivity Slider until a lot of slices appear.

3. Activate “Show Grid” on the View menu and work on the slices with 
the Mute and Lock tools until you have one slice per eighth note or 
sixteenth note.
In many situations there will be no sound on a certain eighth or sixteenth 
note. There’s not much you can do about this. You can copy another MIDI 
note in the sequencer later, or insert a new one “by hand”. You can also add 
a slice manually, at any position.

4. Set the Time Signature and length (Bars/Beats) to whatever the 
length of the loop.
The Tempo gets calculated.

5. Make sure “Silence Selected” and “Export as One Sample” are not 
activated on the Process menu.
These items should not be ticked.

6. Select Export from the File menu and save as a Standard MIDI File.

DDDD If you use Propellerhead’s Reason, applying a groove to existing 
music is a piece of cake. Just Import the MIDI File (or open a REX2 
file - you can simply use the “To Track” function to create MIDI data 
from the REX2 file) in Reason and select “Get User Groove” from 
the Edit menu.

Quantizing Audio 
If you have sliced a groove or other recording, you can apply quantizing to it in 
the sequencer, if you like.

! Always use at least a small amount of Stretch, to avoid the gaps be-
tween slices that might otherwise occur.

Please note that if you have two REX2 loops in Reason, applying the timing of 
one of them to the other is really easy. Use the “To Track” function in Dr. Rex for 
one of the loops, and select the resultant MIDI notes in the sequencer. Now se-
lect “Get User Groove” on the Edit menu. Now you can quantize the other loop’s 
MIDI note data using the User Groove (see the Reason manual for details).

If you don’t like what you get, Undo the Quantize, and try the other way around, 
for example.
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Extracting Sounds
This can be used to extract single sounds (snares, hi-hats etc.) from a loop or 
other recording. It can also be very useful if you have recorded more than one 
drum loop into a file and want to save each one as a separate file. 

1. Open the sample.

2. Raise the Sensitivity Slider until the desired number of slices ap-
pears.

3. Set “Bars” to any value but zero.

4. Click the Preview Toggle button to enter Preview mode.

5. Work on the slices with the Mute and Lock tools until you get the 
sounds you want when you audition.
In the case of the “multi-loop” file outlined above, this would mean one slice 
per loop.

6. Set the Loop point to enclose the first and last sound you want from 
the audio file.
You can use “Silence Selected” to prevent certain slices from being ex-
ported if you wish.

DDDD Also in the case of the multiple loop or Silence Selected scenario, 
you could use the Gate Sensitivity parameter to prevent silent pas-
sages from being exported as part of the file.
See page 56.

7. Use Export Sound to save each slice as a file in a format of your 
choice.

Using loops with unusual 
length or cutting
Sometimes you don’t have a full bar of a loop. Set up the loop and the Bars and 
Beats fields for as much as you have. Then slice the loop. Finally, use your se-
quencer’s editing capabilities, on the MIDI notes, to recreate the missing parts.

You will also encounter situations where the best loop doesn’t really start on a 
downbeat. It might for example happen that you get the best loop when you po-
sition the Left and Right Locator on the last quarter note of two consecutive 
measures.

If this happens, you can fix it in your sequencer, by cutting the last quarter note 
of the MIDI Part and pasting it in at the beginning, to position the downbeat cor-
rectly. If you don’t want to slice the loop completely, at least allow a slice at the 
downbeat (the Lock tool is ideal for this). Then, repositioning that last quarter 
note to the beginning of the loop will be very easy. 

✪ In the included ReCycle + Reason Quick Start Guide there are sev-
eral examples of how you can use your ReCycle files in the Reason 
application.
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Auditioning Audio files 27
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Bars 50
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C
Color 33
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Contrast Slider 33
Copyright 6
Crop Loop 56

D
Drag and Drop 28

E
Effects

Activating 52
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Equalizer 54
Opening Effect Panels 52
Presets 52
Transient Shaper 54

Export As One Sample 58
Export Groove MIDI File 60
Extracting Sounds 70

F
File
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Opening 26, 28
Saving 58
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Gain 56
Gate Sensitivity 56
Grooves 69

H
Help Contents 18

I
Internet 12, 18
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Lock Tool 31, 46
Loop 49
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And Sounds 26
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MIDI Files
Exporting Groove 60

Multiple Undo 34
Mute Tool 31, 44

N
Normalize 55, 66

O
Open 26

P
Pencil Tool 31, 47
Pitch 56
Play

Loop 40
Open dialog 27
Slices 40

Preferences
View stereo files as sum of L+R 33

Preview mode 41
Preview Pitch 56
Preview Tempo 56
Processing

Crop Loop 56
Gain 56
Normalize 55
Pitch 56
Re-Analyze 56

R
RCY files 27
Re-Analyze 56
ReCycle Documents 27

S
Sample Rate

Window title 31
Save/Save As 58
Selecting 47
Sensitivity slider 44
Sign 50
Silence Selected 59, 68
Slice Audition buttons 40
Slices

Adding & Moving Manually 47
Adding using Sensitivity 44
Auditioning 40
Locking 46
Muting 44
Selecting 47

Song Position 32
Sound Designer II 27
Speaker tool 40
Split Stereo Files 28
Status Bar 31
Stretch 53
Support 12, 18

T
Tempo 56

Calculated 50
Changes, Slicing for 67

Thumbnail
Scrolling 33
Setting Magnification 33

Time Signature 50
Toolbox 31

U
Underruns 17
Undo/Redo 34
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Wave files 27, 60
Waveform Display Options 33
Window title 31

Z
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